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[Trademarks]

"UMD" and "PlayStation" are registered trademarks of Sony Computer Entertainment Inc.

"PSP" is a trademark of Sony Computer Entertainment Inc.

"Memory Stick" is a trademark of Sony Corporation.

"XMB" is a trademark of Sony Corporation and Sony Computer Entertainment Inc.

"Photoshop" is a trademark or registered trademark of Adobe Systems Incorporated in the United
States and other countries.

[Terms and Conditions]

All rights (including, but not limited to, copyright) pertaining to this Guideline are managed, owned,
or used with permission, by SCEIL. Except for personal, non-commercial, internal use, you are
prohibited from using (including, but not limited to, copying, modifying, reproducing in whole or in
part, uploading, transmitting, distributing, licensing, selling and publishing) any of this Guideline,
without obtaining SCEI’s prior written permission.

SCEI AND/OR ANY OF ITS AFFILIATES MAKE NO REPRESENTATION AND WARRANTY,
EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OR
REPRESENTATIONS WITH RESPECT TO THE ACCURACY, RELIABILITY, COMPLETENESS,
FITNESS FOR PARTICULAR PURPOSE, NON-INFRINGEMENT OF THIRD PARTIES RIGHTS
AND/OR SAFETY OF THE CONTENTS OF THIS GUIDELINE, AND ANY REPRESENTATIONS
AND WARRANTIES RELATING THERETO ARE EXPRESSLY DISCLAIMED.

EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAWS, SCEI AND/OR ANY OF ITS
AFFILIATES SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE ARISING OUT OF YOUR
USE OR INABILITY TO USE THIS GUIDELINE, OR ANY ALTERATION OR CHANGE OF THE
CONTENTS OF THIS GUIDELINE.
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1 About This Document

Overview

This document contains information and guidelines for creating custom themes and
customized icons for the XMB™ that is part of PSP™ system software.
Specifically, the following topics are covered.

e Types of icons that can be customized

¢ Image size and format

¢ Additional data besides icons that are needed

e Other information

©SCEI PSP™ Custom Theme



‘ 2 Data That Can be Customized

The following data can be customized using the custom theme function.
Category Icons (Horizontal List)

Category icons indicate categories that are arranged horizontally in a row.

B/21 21:30 4m]
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= Memory Stick™

Free Space 1710 MB

The following eight types of category icons can be specified.
Category Type Notes

Network

Game

TV Only for systems sold in Japan and PSP-2000 systems

Video

Music

Photo

Settings

Default Default icons are prepared in advance to support additional icons that
may be added in a future system update.
When only a default icon is specified, all icons can be displayed to be the
same.

First Level Icons (First Level Vertical List)

The first level icons are displayed vertically in a column when a category icon is selected.
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The following first level icons can be set.
Category First Level

Network

Online Instruction Manuals

Remote Play

Internet Radio

RSS Channel

Internet Browser

Game

Game Sharing

Saved Data Management

UMDTM (*)

PSP™ Update

Memory Stick™ (¥)

Video

UMDTM (*)

Memory Stick™ (¥)

Music

UMDTM (*)

Memory Stick™ (¥)

Photo

Camera

Memory Stick™ (¥)

Settings

Network Update

USB Connection

Video Settings

Photo Settings

System Settings

Theme Settings

Date & Time Settings

Power Save Settings

External Display Settings (PSP-2000 only)

Sound Settings

Security Settings

RSS Channel Settings

Network Settings

Other

Default

(*) UMD™ and Memory Stick™ icons are customized one at a time regardless of the category.
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Second Level Icons (Second Level Vertical List)

The second level icons are displayed vertically in a column and to the right of the first level
icons when a first level icon is selected. You can use a custom theme to customize the second

level icons of the Settings category (wrench icons in the figure below).

B/21 17:40 1]
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Settings
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Wallpaper

You can specify wallpaper that is to be affixed to the background.

Theme Color

One of twelve theme colors can be specified by selecting [Settings] > [Theme Settings] >

[Themel, enabling you to set a specific background color that is best suited for a particular

custom theme.

You can also specify no theme color.

Preview

This is used to specify icons and images that will be displayed when the custom theme is

selected.
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List of Customizable Icons

The following icons can be customized.
Category First Second Display Name
Level Level I

@

?

Online Instruction
Manuals

UMD™

PSP™ Update

Network .
o Remote Play
= Internet Radio
@ RSS Channel
W Internet Browser
-y g: Game Sharing
Game (| Saved Data Management
.|

Memory Stick™

(m

TV

:m] UMD™

Video Memory Stick™
J'J UMD™

Music Memory Stick™
o] Camera

Photo Memory Stick™
o= Network Update

Settings USB Connection

Video Settings

Photo Settings

System Settings

Theme Settings

Date & Time Settings

Power Save Settings

ot vdi-Fisdh e THIT IO TO

o
2

External Display Settings

Sound Settings

Security Settings

i flo] -

RSS Channel Settings

Network Settings
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| 3 Image Sizes and Formats

This section presents detailed information concerning the image sizes and formats that are

used in a custom theme.

Category Icons (Horizontal List)

The image size and format for category icons are as follows.

Image size 64 x 48 pixels
Image format 256-color 32-bit CLUT (a
channel enabled)
PNG/TGA/GIM file
RGB a channel
48 pixels
64 pixels

First Level Icons (First Level Vertical List)

The image size and format for first level icons are as follows.

Image size Icon body 48 x 48 pixels
Icon focus 64 x 64 pixels

Image format 256-color 32-bit CLUT (o channel
enabled) PNG/TGA/GIM file

Icon body
RGB a channel
48 pixels
48 pixels
©SCEI PSP™ Custom Theme
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Icon focus

RGB a channel

64 pixels

64 pixels

Second Level Icons (Second Level Vertical List)

The image size and format for second level icons are as follows.

Image size Icon body 32 x 32 pixels
Icon focus 48 x 48 pixels
Image format 256-color 32-bit CLUT (o channel
enabled) PNG/TGA/GIM file
Icon body
RGB a channel
32 pixels
32 pixels
Icon focus
RGB a channel
48 pixels
48 pixels
Wallpaper

The image size and format for the wallpaper are as follows.

Image size 480 x 272 pixels
Image format 24-bit color RLE uncompressed
bitmap file

©SCEI
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272 pixels

480 pixels

Theme Color

The theme colors that can be selected are shown below.

Theme Color Number

Change monthly 0
- 1
2
j 3
.. 4
5
6
7
8
9
10
11
| E—

Preview

The image size and format for the preview are as follows.

Image size Preview icon 16 x 16 pixels
Preview image 300 x 170 pixels
Image format Preview icon PNG/TGA/GIM file
256-color 32-bit CLUT (o channel enabled)
Preview image 24-bit color RLE uncompressed
bitmap file
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Preview icon

RGB a channel

16 pixels

16 pixels

Preview image

170 pixels

300 pixels

©SCEI
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|4 Notes on Icon Design

This section contains notes on icon design.

Icon Data

When creating an icon, avoid painting the icon with a single color. This is because the user can
set any arbitrary background color using the wallpaper setting function. Icons should be
designed with gradations or borders so they can be easily distinguished from arbitrary
background images.

For example, with the following single-color icon data, the icon will not be visible if the

background is set to white.

lcon data Display on white background

In this case, you can make the display easier to see by using gradations and borders as shown

below.

©SCEI PSP™ Custom Theme
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[con data Display on white background

ala
(=) (A
[ o A

Note that when using icon data provided by the system software for your design, you cannot

change its original shape or meaning.

Focus Data

When you create icon data, you also need to create focus data which is used when the icon
receives focus. In the standard theme that is part of system software, focus has been designed
in a consistent manner so that the item receiving the focus will appear to light up in white. If
you create focus data with a similar appearance, it will be easier for the user to recognize that
the focus is on that icon.

The following example shows how Photoshop can be used to create illuminated focus data.

©SCEI PSP™ Custom Theme
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How To Make PSP lcons

FOCUsS

Add the alpha chanmel and copy-paste KON on it

Gaussian Blur: 5, Opixel

CE=roeeT |

[Select » Load Selechon,. ]
Lo the alpha chahinel (of thia fle] as welection
|Edit > Delete]
e that selection on AGE channedy
Copy RGB image fo the alpha channel
Fainl RGB layers all white.

Duplicale tha layer twice. i — [Layer > Flatten Image]
(i increase the contrast) e Merge all layers.
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‘ 5 Setting Custom Themes

This section explains how to set a custom theme on the PSP™ gystem.

Select Theme Settings under the Settings category to set a custom theme.

Settings

Q: Theme Settings

Select Theme under Theme Settings.

The word "Original" and preview icons of theme files that are saved under /PSP/THEME on
the Memory Stick™ are displayed on the right side of the screen. "Original" means that these
are standard icons used in the PSP™ gystem.

A preview image of the selected custom theme is displayed in the center of the screen.

©SCEI PSP™ Custom Theme
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You can change the custom theme by selecting a custom theme from the list and then selecting

Apply. If you select Delete, the selected theme file will be deleted from the Memory Stick™.

Lriginal

tiCookies
m
m @
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| 6 Custom Theme Creation Tool

This section describes the Custom Theme Converter (themeconv.exe), which is a tool for

creating custom themes.

Information Tab

The following items can be entered on the Information tab.

-

Ll Gustom Theme CGonverter E]
FilelEdy  HelptH)
Infarmation l'l.l'l.l'allpaper ] Cateeory Icons | First Level lcons | Second Level Io 4 | *

Title : |

Product ID : |

erzion :

Ttem Description

Title Title information (max. 128 byte UTF-8 string)

Product ID Product ID number (max. 48 bytes)

Usable characters: half-width alphanumerics, hyphen ("-"), and
underscore ("_")

Version Theme version (max. 8 bytes)

A combination of at most 3 numbers from 0 to 99 separated by
periods (".")

For details about how to use the Information tab, see Chapter 7, "Using the PSP™ to

Download Custom Theme Data."

©SCEI PSP™ Custom Theme
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Wallpaper Tab

This tab is used to set the image file that will be used for wallpaper. By clicking on the preview
button, the wallpaper setting can be previewed. For information about files that can be set as

wallpaper, see Chapter 3, "Image Sizes and Formats."

-

Ll Gustom Theme Converter E] ]
File(E}  HelptH)
Information  Wallpaper lGategDry Icons | First Level Ioons ] Second Level Ic 4 | *

Wallpaper : | E

©SCEI PSP™ Custom Theme
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Category Icons Tab

This tab is used to set the image files that will be used for the category icons. By clicking on

the Preview button, the category icons can be previewed. For information about files that can

be set as category icons, see Chapter 3 "Image Sizes and Formats."

-

Ll Gustom Theme Converter

MEX]

File(E}  HelptH)

Information ] Wallpaper Tategory Izons | First Level Icons | Second Level I 4| *

Item

Icon Body

=" :
el Settings

Edit

Clear

[

2]

Presiew |

The default icon is used for category icons that have not been set. If the default icon itself has

not been set, the original icon is used instead. This also applies to new category icons that will

be added in future updates.

©SCEI
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First Level Icons Tab

This tab is used to set the image files that will be used for the first level icons and focus. The
Edit button will switch to the file selection screen and the Clear button will clear the selected
file. By clicking on the Preview button, the first level icons and focus can be previewed. For
information about files that can be set for the first level icons and focus, see Chapter 3 "Image

Sizes and Formats."

-

Ll Gustom Theme Converter E]
File(E}  HelptH)
Information ] Wallpaper ] Category Icons  First Level loons ]Semnd Level Ic 4 | *

Item Icon Body lcon Focus

k3

Ml Memory Stick(TM)

@ LMD (TM)

KW Camera
g:-' Game Sharing
(] Saved Data Utility

A3 PSPOTMY |Indate Nata I
<] I Ea

Edit Clear Presiew

The default icon 1s used for first level icons that have not been set. If the default icon itself has
not been set, the original icon is used instead. This also applies to new first level icons that

will be added in future updates.

©SCEI PSP™ Custom Theme
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Second Level Icons Tab

This tab is used to set the image files that will be used for the second level icons and focus. The
Edit button will switch to the file selection screen and the Clear button will clear the selected
file. By clicking on the Preview button, the second level icons and focus can be previewed. For
information about files that can be set for the second level icons and focus, see Chapter 3

"Image Sizes and Formats."

-

Lal Custom Theme Converter E] |
File(E}  HelptH)
Wallpaper ] Category Ieonz | First Level Ions  Second Level lcons lOthers AL

Item Icon Body lcon Focus

Edit Clear Presiew

The default icon 1s used for second level icons that have not been set. If the default icon itself
has not been set, the original icon is used instead. This also applies to new second level icons

that will be added in future updates.

©SCEI PSP™ Custom Theme
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Others Tab

This tab is used to set the image files that will be used for the preview icon and preview image,
and also to select the theme color. By clicking on the preview buttons, the preview icon and
image can be previewed. For information about files that can be set for the preview icon and

preview image, see Chapter 3 "Image Sizes and Formats."

-

Lal Custom Theme Converter E]
File(E}  HelptH)
Category Icons ] First Level Iconz | Second Level Ioons  Others ] bl L

Preview Ioon : || E
Preview Image : | ﬂ
Theme Color : B honth 'l

File Menu

The File menu enables you to perform "New”, “Open” and “Save” operations on files that save
custom theme settings. You can also select "Write" to write the current settings to a custom

theme file.

Help Menu

The Help menu enables you to change settings for themeconv.exe.

You can set the display language to Japanese, English, or Korean from the Settings menu.

©SCEI PSP™ Custom Theme
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| 7 Using the PSP™ to Download Custom Theme Data

This section describes how the PSP™ Internet browser can be used to download custom theme

data.

Meta Information and Download Processing

When the PSP™ Internet browser downloads custom theme data, it uses meta information on
both the server and the inserted Memory Stick™ to automatically control the download
process.

The meta information that it uses consists of the title, the product ID, and the theme version.

These are described below.

Title

Title is the 128-byte (max) UTF-8 string previously specified for "title". It is displayed on
the download start confirmation screen.

If the title is too long for the display, it will either be abbreviated or automatically scrolled.
To prevent titles from being abbreviated or scrolled, they should be no more than
approximately 20 characters long for Japanese, Korean, and Chinese, and 30 characters for

all other languages.

Product ID

Product ID is the 48-byte (max) string previously specified for "product_id". It is used for
the target filename for the download.
If each custom theme is assigned a different product ID, files can be automatically

downloaded and saved with different filenames.

Theme Version

Theme version is the 8-byte (max) string previously specified for "theme_version". It is
displayed on the download start confirmation screen.

The theme version is also used to determine whether or not downloading should be
executed.

If the Memory Stick™ already has custom theme data with the same product ID as that
which is being downloaded, the theme versions are compared and the data is downloaded
only if it is newer.

The theme version is assumed to be a combination of at most 3 numbers from 0 to 99

separated by periods ("."), One theme version is newer than another if it has more numbers

©SCEI
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or if its numbers are larger than the other.

Examples
e "1.00"
o "1L.1.1"
o "12V
o "12.34.56"

e "1.1"is newer than "1.00"
e "1.10"1s newer than "1.1"

e "1.1.1"is newer than "1.1"

Therefore, when you update your custom theme data, you can cause it to be downloaded

only when necessary by making the theme version newer.

Uploading Custom Theme Data to the Server

To upload your custom theme data to the server for later download via a PSP™ Internet
browser, the custom theme data must be assigned a special MIME-Type and extension.

The MIME-Type and extension are shown below.

MIME-Type ' Extension
application/x-psp-theme ptf

©SCEI PSP™ Custom Theme
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| 8 Appendix

Maximum Size

The maximum size of a custom theme file is 768KB.

Compatibility

Custom theme files created with version 1.2.0.0 of themeconv.exe can be used with PSP™
system software version 3.80 or later. They cannot be used with earlier versions of PSP™
system software. Custom theme files created with earlier versions of themeconv.exe can

continue to be used.
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